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Introduction 
 
At the turn of the twentieth century, Virginia’s wildlife populations were low.  Many species 
plentiful today such as the deer, beaver, and blue heron, had all but disappeared from the 
Commonwealth because of a lack of understanding about how wildlife populations respond 
to over hunting and because there were no laws safeguarding animal numbers.  In 1916 the 
Virginia General Assembly established the Department of Game and Inland Fisheries to 
bring species like these back through legislation and effective wildlife management 
techniques.  
 
The scientific field of wildlife management was new and experimental in the early 20th 
century.  A variety of methods to restore wildlife populations were tried and many failed. 
Today, we know that habitat management, based on sound research, is the key to long term 
survival of any species.   To be able to manage a habitat for the food, water, shelter and 
space needs of any given species, we need to know what the species’ requirements are.  
Wildlife biologists at the Department of Game and Inland Fisheries design research projects 
that identify the habitat requirements as well as assess the health of the population.  The 
statistics provided in this guide are the result of many years of data collection that has been 
based on a variety of research methods. 
 
The Department also depends upon public support for the collection of additional data that 
otherwise would be difficult to obtain.  Certain wildlife species can be hunted without 
adversely affecting their population.  Citizens who hunt for deer and turkey are asked to 
provide age and sex of the animals they hunted. This provides a large sample size that 
could not be collected in other ways. Smaller samples of the population are taken through 
other methods including the mark and recapture technique, direct observations and actual 
counts.   
 
For some species the Department uses the latest in technological methods.  For example, 
the data on the swan activity was collected using satellite transmitters placed on just a few 
swans. Since swans fly in large flocks, only a few birds needed to be followed.  What we 
found is that not all swans that winter in Virginia return to the same nesting grounds but 
instead scatter across the northern portion of Canada and Alaska. Similar transmitters have 
been placed on sea turtles, peregrine falcons and pintail ducks over the past 20 years.  
Radio transmitters followed by plane, boat or on foot have been also placed on bears, fish 
and even on the endangered canebrake rattlesnake.   
 
Biologists Virginia Department of Game and Inland Fisheries are experts in their field; many 
have a Masters or Doctorate Degree in Wildlife Resource Management. If students would 
like additional information on careers in wildlife , visit: 
http://www.dgif.virginia.gov/jobs/careers-pamphlet.html#Wildlife . 
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A Weighty Issue   
 
Overview:  
In this activity, students graph the growth of bear cubs that were part of a reproductive study done at 
Virginia Tech. 

SOL Connections: 
Math 8.12, 7.16, 7.18 
Science 6.1, LS.1, LS.8 

 
Background: 
Black bears are found in all but a few eastern counties of Virginia, but the densest populations are in the 
western mountainous part of the state and in the south east corner, mainly the Great Dismal Swamp and 
surrounding areas. The population of bears is growing and spreading to practically all counties of the 
Commonwealth. The total number of bears in Virginia may be about 7,000 animals. Bears are nearly 
always solitary animals, with the exception of family groups (sow with cubs).  The male and female have 
little or no contact other than during mating. Females spend a lot of effort feeding and fattening up before 
going into hibernation in order to produce healthy cubs.  As part of a study conducted by the VA 
Department of Game and Inland Fisheries and VA Tech, small samples of female black bears or sows were 
placed into captivity before hibernation.  The sows were pregnant and gave birth to their cubs during the 
winter hibernation.  The purpose of the study was to obtain growth data on cubs in order to be able to 
assess the health of cubs in the wild population.  Similar data is being collected on sows and their cubs in 
the wild for comparison.  
 
The cubs are born at about 224 grams or about the size of a guinea pig; they grow rapidly.  At one year, 
cubs will grow from the 224 grams to about 22.50 to 31.50 kg.  As part of the research project, every 10 
days, the sows were immobilized and the cubs were weighed and other growth data recorded.  Afterward, 
cubs were returned to their mothers who then woke up and continued to care for them.  Once spring arrived 
and food was again plentiful, the sow and her cubs were released back into the wild.   
 
More information on black bears and Virginia’s Bear Management Plan can be found at 
www.dgif.virginia.gov. 
 

Problem:  Create a box and whiskers plot and determine the appropriate measure of central tendency. 
Enter data from the data table.  Calculate the average weight of a bear cub at various stages of 
development. 
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Data table 

CUB WEIGHT IN GRAMS 
CUB 5 DAYS 45 DAYS 85 DAYS 

1 581.7 1939.6 2400 
2 520.5 1588.3 2050 
3 310.8 988.1 2600 
4 387.4 1670.6 2650 
5 331.6 1287.8 2700 
6 358.7 962.3 1600 
7 311.5 1443.5 2400 
8 408.7 1108.5 1800 
9 369.0 1680.0 2500 
10 364.3 1650.0 2450 
11 393.9 1135.8 2600 
12 364.8 1365.8 3200 
13 348.7 1474.9 2700 

 
 

Key strokes: 

1. Refer to Appendix I. Calculator Set Up 
2. Press STAT , Select 1:Edit, Press ENTER 
3. Clear L1. Use the arrow keys to place the cursor on L1, Press CLEAR, ENTER to clear the list.  Repeat 

for L2, L3, and L4 
4. Enter cub number in L1. 
5. Enter cub weight at 5 days in L2. 
6. Enter cub weight at 45 days in L3 
7. Enter cub weight at 85 days in L4 
8. Press 2nd STAT PLOT. Select Plot 1, Select ON and Box and Whisker Plot with outliers. 

9. Make selections using arrow keys to match  figure 1 

 

 

 

            

 

Figure 1 
 
 
 
 
 
 



 Virginia Department of Game and Inland Fisheries - 2005 7 

10. Press ZOOM, 9 to create a box and whisker plot with outliers.  Press TRACE and use the arrow keys 
to determine: 

Min: ______________                   3rd Quartile: __________ 

1st Quartile: ________    Outliers: _____________ 
Med:______________            Max: ______________ 

11.  Press 2nd STAT PLOT?, select 2:Plot 2, turn plot on, make selections using arrow keys to match  

figure 2 

 
    
     
     
 
  
 
                                             

                                                      Figure 2                                  

12. Press 2nd STAT PLOT?, select 3:Plot 3, turn plot on, make selections using  arrow keys to match 

figure 3 

 
 
 
 
 

 

                  Figure 3 

 
13. Press ZOOM 9 to graph 
 
14. Press TRACE and use the arrow keys to show the quartile and median values for each box and 

whisker plot. 
5 Days     45 Days   85 Days 

 Min:_________   ___________   __________ 
 Q 1: _________   ___________   __________ 
 Med: ________    ___________   __________ 
 Q 3: _________   ___________   __________ 

Max: ________   ___________   __________ 
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15. Sketch your plots below. Remember a graph needs a Title and Axes Labels. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
16. To determine the modes for Lists 2, 3, and 4.  Press STAT, Select 3:Sort D and add L2, L3, L4. See 

Figure 4 below. 
 
 
 
 
 
 
             

  Figure 4 
 

17. Press STAT select 1:Edit, press ENTER 
18. Review Lists 2,3, and 4 data to identify the modes 
19. List the modes for each time span:  

5 days________________  
45 days_______________ 
85 days _______________ 

 
Analysis questions: 

1.  Using the weight data, which measure of central tendency best describes the normal weight of cubs for 
each age? 
 
2.  In which quartile do the majority of the weights fall for 5 days, 45 days, and 85 days? 
 
 
3. Are there any outliers, and if so, what are they? 
 
 
4. Is there an age where the bear weight values differ more than the others? 
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Teacher Notes – A Weighty Issue: 
 
1. The first 5 days bear cub growth will create a box and whisker plot with outliers.  See figure 1. 
 
 
 
 
 
 
 
 
  
          Figure 1 
2. The second two graphs, 45 days and 85 days do not have outliers.  If all three graphs are displayed on 

the same screen they will show statistical bear cub growth. See figure 2. 
 
 
 
 
 
 
 
 
 
 
        Figure 2 
3. You can explore further statistics by pressing STAT, arrow right to CALC and selecting 1: 1-Var Stats. 

Then add the list you wish to be analyzed. See figure 3 and figure 4. 
 

 
 
 
 
 
 
 
 

                  Figure 3                                                                           Figure 4 
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Can You Bear the Weight?  
 

Overview:  
Students will graph the weight of male and female bear cubs and determine which grows faster. 
 
SOL Connections: 
Math 7.5, 7.18, 8.12, and 8.14 
Science 6.1, LS.1, LS.8 

Background: 
Black bears are found in all but a few eastern counties of Virginia, but the densest populations are in the 
western mountainous part of the state and in the south east corner, mainly the Great Dismal Swamp and 
surrounding areas. The population of bears is growing and spreading to practically all counties of the 
Commonwealth. The total number of bears in Virginia may be about 7,000 animals. Bears are nearly 
always solitary animals, with the exception of family groups (sow with cubs).  The male and female have 
little or no contact other than during mating. Females spend a lot of effort feeding and fattening up before 
going into hibernation in order to produce healthy cubs.  As part of a study conducted by the VA 
Department of Game and Inland Fisheries and VA Tech, small samples of female black bears or sows were 
placed into captivity before hibernation.  The sows were pregnant and gave birth to their cubs during the 
winter hibernation.  The purpose of the study was to obtain growth data on cubs in order to be able to 
assess the health of cubs in the wild population.  Similar data is being collected on sows and their cubs in 
the wild for comparison.  
 
The cubs are born at about 224 grams or about the size of a guinea pig; they grow rapidly.  At one year, 
cubs will grow from the 224 grams to about 22.50 to 31.50 kg.  As part of the research project, every 10 
days, the sows were immobilized and the cubs were weighed and other growth data recorded.  Afterward, 
cubs were returned to their mothers who then woke up and continued to care for them.  Once spring arrived 
and food was again plentiful, the sow and her cubs were released back into the wild.   
 
More information on black bears and Virginia’s Bear Management Plan can be found at 
www.dgif.virginia.gov. 
 
Question:  Which cub will grow faster, the male or female bear cubs? 
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Data tables: 
WEIGHT DATA FOR 10 MALE CUBS IN GRAMS 

DAYS CUB1 CUB2 CUB3 CUB4 CUB5 CUB6 AVG 
5 311.5 348.7 369 364.3 393.9 364.8 358.7 
15 419.9 610.2 605.5 617.7 571.9 625. 575.0 
25 668.7 910.1 933.5 904.9 771.7 889.7 846.4 
35 987.3 1181.1 1258.1 1165.7 941.4 1149.1 1113.8 
45 1443.5 1474.9 1680 1650 1135.8 1365.8 1458.3 
55 1583 1775.1 1850 1700 1321 1596.2 1637.6 
65 2000 2100 2100 2000 1593.1 1971.2 1960.7 
75 2400 2700 2500 2450 1600 2100 2291.7 
85     2600 3200 2900 

DAY CUB 7 CUB 8 CUB 9 CUB 10 AVG 
7 599.0 508.1 390.0 435.9 483.3 
17 1037.2 917.9 705.0 672.9 833.3 
27 1508.4 1377.1 1020.0 926.0 1207.9 
37 1999.2 1791.8 1200.0 1116.3 1526.8 
47 2343. 2200 1410.0 1350.9 1826 
57 2800 2600 1680.0 1542.2 2155.6 
67 3000 2750 1750.0 1850.0 2337.5 
77 3000 2800 1800.0 2300.0 2475 

 
 

WEIGHT DATA FOR 10 FEMALE CUBS 
DAYS CUB 1 CUB 2 CUB 3 CUB 4 CUB 5 AVG 

1 366 480 287 402.2 349.2 367.9 
11 686 797 450 632.5  580 629.1 
21 1095 1297 637 915.8 863.4 961.6 
31 1490 1942 1299 1216 1107.6 1410.9 
41 1879 2146 1005 1499 1402.2 1586.2 
51 2200 2550 900 1716.1 1648.9 1803 
61 2700 3000 1005 2100 2050 2171 
71 3550 3850  2500 2400 3075 

DAYS CUB 6 CUB 7 CUB 8 CUB 9 CUB 10 AVG 
9 634 545.9 511.7 412.4 470.7 514.9 
19 1120 1098.5 1076.6 752.3 826.8 974.8 
29 1590 1412.3 1373.6 1101.8 1108.3 1317.2 
39 2042 1513.5 1373.9 1464.1 1437.4 1566.2 
49 2300 1829.5 1812.6 1774.9 1754.6 1894.3 
59 2650 2128.7 2384 2040.8 2022.9 2245.3 
69 2900 2400 3400 2300 2250. 2650 
79 3000 3250 4250  2560  3265 
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Keystrokes: 

1. Refer to Appendix I. Calculator Set Up 
2. Press STAT, 1, ENTER 
3. Clear L1. Use the arrow keys to place the cursor on L1. Press CLEAR, ENTER to clear the list.  

Repeat for L2, L3 
4. Enter male time periods (days) in L1. 
5. Enter male average weights in L2. 
6. Enter female time periods (days) in L3 and female average weights in L4.  See sample data in  

figure 1. 
 
 
 
  
  
 
 
 
 
                                       Figure 1 

7. To be sure that your data is sorted chronologically, press STAT, select 2: Sort A  (Press L1, L2) 
figure 2 

8. Repeat for L3 and L4 
 
 
 
 
 
 
 
 
 
    Figure 2 
 

9. Press 2nd, STAT PLOT, ENTER  to choose a line graph) 
10. Make selections using arrow keys to match figure 3 

 
 
 
 
 
 
 
 
                                        Figure 3  
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11. Press 2nd, STAT PLOT, select 2:Plot 2, turn plot on, make selections using arrow keys to match 
figure 4 

 
 
 
 
 
 
     
 

                                      Figure 4 
                                               

12. Press ZOOM, select 9 
13. GRAPH  See sample graph in figure 5.    

 
 
                                   
                                
 
 
 
 
 
                          Figure 5 
 
 
Draw your graph here.  Remember to title the graph.  Each axis should be labeled. 
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Analysis questions: 
1. Is there a difference in growth between male and female cubs? 
2. Do they grow at the same rate throughout the 85 days?  Are there times when the growth slows down?  

Do they grow faster at the beginning of their life or later?  (Hint: look at the slope.) 
 
Extension: 

1. Follow the directions below to create a scatter plot with a line of best fit to look at growth trends of 
the male and female cubs.  Then write a short paragraph to explain the slopes of the male and 
female cub growth. 

• Press 2nd STAT PLOT and change PLOT 1 and PLOT 2 to scatter plots (the first icon) see figure 1 
and 2  below. 

 
  
 
 
 
 

 

 

        Figure 1                             Figure 2 
 
• Press STAT, arrow to CALC and select 4:LinReg (ax+b) 
• Press 2nd L1   comma  2nd L2 comma VARS, arrow to Y-VARS, select 1:Function, select 1:Y1 
• Press ENTER to complete the line of best fit for the male cub growth. 
• Press STAT, arrow to CALC and select 4:LinReg (ax+b) 
• Press 2nd L3 comma 2nd L4 comma VARS, arrow to Y-VARS, select 1:Function, select 1:Y2 
• Press ENTER to complete the line of best fit for the female cub growth. 
• Press ZOOM Select 9 to create the graph 
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2. Draw your graph below and write your paragraph explaining the graph. 
 
 
 

 

 

 

 

 
 
 
 
 
 

 
Explanation of graph: 
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Teacher Notes – Can You Bear the Weight? 
1. The student graph will look like figure 1 below.  Notice that the female growth is faster in the final 

days. 
 
 

 
 
 
 
 
 

 
             Figure 1  

2. Since this is authentic data, the mother bears could not all be sedated in order to remove the cubs 
on the same day, so the data is from alternating days.   There were more bears involved in the 
study.  The ten bears selected for the activity are a representation of the total data. 

 
3. Students could also graph the averages as a scatter plot and then use the linear regression 

calculation to create a line of best fit.  The slope of the line represents the growth rate and the y 
intercept represents the first weight measurement. If you are examining the equation, press the Y= 
key to see the calculator generated equations.  It may be a good idea to have the students set the 
calculator to 1 decimal place to avoid large insignificant numbers in the equation.  To do this press 
MODE and use the arrow keys to select 1 on the FLOAT line by pressing ENTER before they do 
the calculations. 

 
4. Line of best fit and scatter plot for cub data figure 2 below 

 
 
 
 
 
 
 
 
 
          Figure 2 
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Deer Population Growth   
 
Overview:   
This activity measures potential growth of a deer population uses data from a hypothetical deer herd as 
well as data from Virginia’s early deer restocking efforts. 
 
SOL Connections: 
Math 
Science LS.1, LS.8, LS.11, LS.12 
 
Background:  
 
Deer had disappeared from western Virginia at the turn of the 20th century.  Unregulated hunting and the 
loss of habitat had eliminated a large portion of the herd.  The Department of Game and Inland Fisheries 
began restoration of the deer herd in1931 by capturing deer in other states and releasing them in Virginia, 
until 1950. Restocking began again in the late 1960s and early 1970s with deer from established herds 
within Virginia. 
 
In the southwestern county of Russell there were no resident deer before the department started restocking 
and transplanting deer.  Russell County received a total of 96 deer from 1933 - 1969.  The deer season 
opened in Russell in 1952 with a short bucks only (male deer) season.  The number of deer taken in 
Russell County since 1947 can be found at 
http://www.dgif.virginia.gov/hunting/va_game_wildlife/deer_harvest.asp?temporalFilter=1994&disp=null 
 
Without any controls on the population, a deer herd will quickly fill the available habitat.  Once the total 
number of deer has passed carrying capacity of the habitat they begin to destroy their habitat.  The activity 
below makes several assumptions: 1)The habitat quality and quantity remain constant, i.e. there has been 
no further human development in the area since stocking. 2) No deer are hit by vehicles, killed by stray 
dogs, or die from disease. 3) Hunting is the only possible source of mortality in the herd.  These factors that 
affect the population are called limiting factors and normally exert some control over any population.  The  
Department of Game and Inland Fisheries manages the size of Virginia’s deer herd by allowing citizens to 
hunt deer. 
 
Problem: How does the deer population in Russell County change overtime? Will hunting affect the 
population? 
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Data Table:  
   Deer stocked in Russell County  

Year stocked  Number stocked 
1933 2 
1937 12 
1968 46 
1969 36 

 
One pair of adult deer, living in a good habitat, can produce two fawns per year. 
Fawns are born 50-50 males and females (bucks and does). Fawns mature at two years of age.  
 
Sample Deer Population Growth Data Table: 

Year Adult M Adult F Fawn M Fawn F Yr M Yr F Total 
Harvest of 

Adult M 
0 1.0 1     2.0  
1 1.0 1 1 1   4.0 0.1 
2 0.9 1 1 1 1 1 5.9 0.1 
3 1.8 2 1 1 1 1 7.8 0.2 
4 2.6 3 2 2 1 1 11.6 0.3 
5 3.4 4 3 3 2 2 17.4 0.3 
6 5.0 6 4 4 3 3 25.0 0.5 
7 7.5 9 6 6 4 4 36.5 0.8 
8 10.8 13 9 9 6 6 53.8 1.1 
9 15.7 19 13 13 9 9 78.7 1.6 

10 23.1 28 19 19 13 13 115.1 2.3 
11 33.8 41 28 28 19 19 168.8 3.4 
12 49.4 60 41 41 28 28 247.4 4.9 
13 72.5 88 60 60 41 41 362.5 7.2 
14 106.2 129 88 88 60 60 531.2 10.6 
15 155.6 189 129 129 88 88 778.6 15.6 
16 228.1 277 189 189 129 129 1141.1 22.8 
17 334.2 406 277 277 189 189 1672.2 33.4 
18 489.8 595 406 406 277 277 2450.8 49.0 
19 717.8 872 595 595 406 406 3591.8 71.8 
20 1052.1 1278 872 872 595 595 5264.1 105.2 
21 1541.9 1873 1278 1278 872 872 7714.9 154.2 
22 2259.7 2745 1873 1873 1278 1278 11306.7 226.0 
23 3311.7 4023 2745 2745 1873 1873 16570.7 331.2 
24 4853.5 5896 4023 4023 2745 2745 24285.5 485.4 
25 7113.2 8641 5896 5896 4023 4023 35592.2 711.3 
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Keystrokes 

Use the following keystrokes to create a sample graph of deer population growth. 
1. Refer to Appendix I. Calculator Set Up 
2. Enter data into graphing calculator. Press STAT, ENTER and clear L1 and L2 by placing the cursor 

on L1 and pressing CLEAR and ENTER Repeat for L2  and L3.  Enter Year Number data into L1 and 
Total Population into L2, and Harvest into L3. 

 
3. To create a scatter plot of the deer population, Press 2nd, Y=.    Choose 1: Plot 1and On. Use the 

arrow keys to highlight the choices on figure1 
 
 
 

 
 
 
 
 
 
                                    Figure 1 
 

4. Look at your year data to determine: 
X min ______, X max _________, X scale _________ 
Y min ______, Y max _________, Y scale _________ 
 

5. Press WINDOW and replace the 0’s with your correct values. 
 
 

 
 
 
 
 
 
 

6. Press GRAPH and use TRACE to draw your plot below.  Remember a graph needs a Title, and 
Axes Labels. 
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7. The curve of the data suggests that this is an exponential relationship.  To create a line of best fit: 
Press STAT, arrow right to (CALC), select 0: ExpReg. 

8. Press 2nd 1, 2nd 2, VARS arrow right to? Y-VARS, select 1: Function, select 1:Y1. Your home 
screen should look like figure2. 

 
 

 
 
 
 
 
 
      

Figure 2 
9. Press ENTER to complete calculations 
10. Press GRAPH to view the graph with the line of best fit.  Add the line of best fit to your plot above. 
11. Press Y= to view the equation for the line of best fit. 
12. To create a scatter plot of the harvest. Press 2nd, Y=.    Choose 2: Plot 2and On. Use the arrow 

keys to highlight the choices on figure3 
 
 
 

 
 
 
 
   
 

Figure 3   
 

13. Look at your year data to determine: 
X min ______, X max _________, X scale _________ 
Y min ______, Y max _________, Y scale _________  
 

14. Press WINDOW and replace the 0’s with your correct values. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 Virginia Department of Game and Inland Fisheries - 2005 21 

15. Press GRAPH and use TRACE to draw your plot below.  Remember a graph needs a Title, and 
Axes Labels. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

16. The curve of the data suggests that this is an exponential relationship.  To create a line of best fit: 
Press STAT, arrow right to (CALC), select 0:ExpReg. 

17. Press 2nd ?1 , 2nd  3, VARS arrow right to? Y-VARS, select 1:Function, select 2:Y2. Your home 
screen should look like figure 4. 

 
 
 
 
 
 
 
      

 
Figure 4 

 
 
18. Press ENTER to complete calculations 
19. Press GRAPH to view the graph with the line of best fit.  Add the line of best fit to your plot above. 
20. Press Y= to view the equation for the line of best fit. 
21. Press 2nd TABLE to view a table of the data.  Use the arrow keys or press GRAPH and TRACE 

and use the arrow keys to determine the answers to the following questions. 
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Analysis Questions 
 

1. How many deer would be in this herd at the end of five years? ______Ten years? ______ 
 
2. What would be the herd size in 25 years?______ In 30 years?________ 

 
3. If hunters harvest 10 percent of the mature bucks each year, how many will they harvest the third 

year?______ The fifth year?_______ The tenth year?_______ 
 

4. Why are your figures not really "true-to-life"?  
 
 
 
 

5. In the real world, what limiting factors can affect the size of a deer herd? 
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Teacher Notes - Deer Population Growth: 
 

1. Students can find answers on the data table, use TRACE and the arrow keys to find answers on 
the graph, or press 2nd TABLE and arrow to the answers.  They can also pres 2nd TBLSET and 
select Indpnt: Ask fig.1.  Then press 2nd TABLE and enter the year for the question.(figure 2) 

 
 
 
 
 

 
 
 
 
                                                       Figure 1                                                          Figure 2 
2. The exponential graph for year and deer population is below. (Figure 3) 

 
 

 
 
 
 
        
 

 
Figure 3 

3. The exponential graph for the year and harvest is below. (Figure 4) 
 
 

 
 

 
 
 
                 
                                                Figure 4 
 

4. If you want to look at the equations for the line of best fit press Y= to view them.  If you want more 
manageable  numbers, press MODE and select 1 or 2 decimal places before  doing the line of best 
fit calculations. 

 
5. If you want to practice sequencing with the students, this can be done in the year list.  Use the 

arrow keys to place the cursor on L1 and press 2nd LIST, arrow right to OPS, select 5:seq (On the 
list screen add to seq (X,X,1,25,1).  The sequence format is: seq(expression, variable, begin, end, 
increment) 

  
 Adapted from Multidisciplinary Wildlife Teaching Activities by Wm. R. Hernbrode, Arizona Game and Fish 
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Flying High with Fledglings  
 
Overview:  
Students will create a graph of the number of nests and fledglings of bald eagles in Virginia and make 
inferences on the reasons behind the growth curve. 
 
SOL Objectives: 
Math 7.18, 8.3, 8.12, 8.14  
Science 6.1, 6.9, LS.1, LS.7, LS.11, LS.12 
 
Background: 

The bald eagle became our national symbol in 1782. As our national symbol, it holds a special place in the 
hearts of our citizens.  Even though the bald eagle has been protected from direct harm by people since the 
Bald Eagle Protection Act of 1940, its habitat was not protected.  By the 1960’s the eagle population began 
to seriously decline until 1972, when it was placed on the U.S. Endangered Species List. The decline was 
the result of DDT poisoning, a pesticide that caused the shells of the eggs to be thin and the embryos to 
develop improperly. The use of DDT in the United States was banned in 1972.  

 The Endangered Species Act provided protection of any eagle’s nest site and surrounding habitat.  In 
1977, the Virginia Department of Game and Inland Fisheries, (DGIF) began tracking the number of nests 
and the number of young fledged. Eagles lay 1 to 3 eggs each year during their reproductive life. Since 
eagles begin nesting in late winter, biologists are able to  fly over the nests and count the number of young 
before the leaves appear on the trees. Later in the year, boat trips counted the number of juvenile and adult 
birds along Virginia’s tidal rivers.  The data table on page 24, shows the number of nests and the number of 
young fledged.   
 
The table that follows shows a recovering population of eagles.  The population will begin to level off once 
the carrying capacity is reached. Carrying capacity is the number of individuals that a given ecosystem 
can support during the year. Several limiting factors determine the number of eagles an area can support, 
including the availability of large trees capable of supporting nests, the distance to a river or other source of 
food, and the frequency of disturbance by outsid e factors such as boats or people walking near the nest 
site.  Mated pairs tend to be territorial around their nests and will defend their nest site from other birds.  
They will continue to use the same nest year after year, adding more sticks each winter until the nest may 
weigh close to 100 pounds. 
 
Eagles will congregate in feeding areas along the rivers and other areas where there is a plentiful food 
source. The sudden availability of a food source such as a fish kill or other carrion can be detrimental to the 
population if that food source is contaminated by pesticides or another poison.   Eagles are capable of 
flying long distances during any given day; or an area may host a large number of birds one week and a 
small number the following week.  The ability to travel long distances to a food source may cause a sudden 
decrease in the population along a river or in a region. 
 
Problem: 
Determine if there is a relationship between the number of eagle fledglings and improved environmental 
conditions.  Did the number of eagles increase with the banning of the pesticide DDT?  What other factors 
may have contributed to the number of eagles nesting in Virginia? 
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Data table 
           Eagle Nest’s and Fledglings by Year 

Date Year  Active Nests Young Fledged 
1977 1 31 18 
1978 2 36 18 
1979 3 34 20 
1980 4 35 35 
1981 5 39 40 
1982 6 45 40 
1983 7 52 51 
1984 8 60 57 
1985 9 65 84 
1986 10 66 83 
1987 11 73 107 
1988 12 80 118 
1989 13 92 88 
1990 14 104 142 
1991 15 110 153 
1992 16 131 141 
1993 17 149 172 
1994 18 144 158 
1995 19 154 223 
1996 20 180 243 
1997 21 214 321 
1998 22 229 314 
1999 23 230 326 
2000 24 270 414 
2001 25 312 465 
2002 26 329 501 
2003 27 371 454 
2004 28 401 612 

 
  

Key strokes: 
1. Refer to Appendix I. Calculator Set Up 
2. Enter data into graphing calculator. Press STAT, ENTER and clear L1 and L2 by placing the 

cursor on L1 and pressing CLEAR and ENTER Repeat for L2.  Enter Year Number data into L1 

and Number Fledged into L2. 
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3. Create a scatter plot. Press 2nd, Y=.    Choose 1: Plot 1and On. Use the arrow keys to 
highlight the choices on figure 1 

 
 

 
 
 
 
 

 
 

Figure 1 
4. Look at your year data to determine: 

i. X min ______, X max _________, X scale _________ 
ii. Y min ______, Y max _________, Y scale _________ 

5. Press WINDOW and replace the 0’s with your correct values. 
 
 

 
 
 
 
 

 
 
 
6. Press GRAPH and use TRACE to draw your plot below.  Remember a graph needs a Title, 

and Axes Labels. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. The curve of the data suggests that this is an exponential relationship.  To create a line of best 
fit: Press STAT, arrow right to (CALC), select 0:ExpReg. 
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8. Press 2nd 1, comma, 2nd  2, comma, VARS ?arrow right to? Y-VARS, select 1:Function, select 
1:Y1. Your home screen should look like figure 2. 

 
 

 
 
 
 
 
 

 
Figure 2 

 
9. Press ENTER to complete calculations 
 
10. Press GRAPH to view the graph with the line of best fit.  Add the line of best fit to your plot 

above. 
 

11. Press Y= to view the equation for the line of best fit. 
 
Analysis Questions 
1. Looking at the graph, what inferences can you make about the relationship between the number of 

young and environmental conditions? 
2. What are factors that would affect the population?  (Hint: The goal of banning DDT and protection of 

nest sites and surrounding habitat was to increase the population, was this successful?) 
3. Will the population continue to increase indefinitely?  Why or why not? 
 
Extensions  
 
1. Use the following directions to determine if in addition to increasing the number of surviving fledglings 

each year, there has been an increase in the number of nests. 
• Enter the nest data in L3 by pressing STAT, ENTER clearing L3 and typing in the number of nests 

for each year. 
• Use 2nd, STAT PLOT, select 2: Plot 2 and create the screen in figure1 below. 

 
 
 
 
 
 
 
 
 
                           Figure 1 
• To create a line of best fit, press STAT, arrow right to CALC and select O:Exp.Reg. 
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• On the home screen add 2nd L1, comma, 2nd L3, comma, VARS, arrow right to Y-VARS, select 1: 
Function, then 2:Y2.  See figure 2  below.     

  
 
 
 
 
 
 
 
                                                    Figure  2 
• Press ENTER to complete calculations.  Set up the window with the correct values. Press GRAPH to 

view the graph with the line of best fit. 
• Draw your graph below.  Remember a graph needs a title and labeled axes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Why is it important to analyze the increase of nests in addition to the increase of fledglings? 
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Teacher Notes – Flying High with Fledglings: 
 

1. The number of fledglings that survive and the number of nests will level off when the population 
reaches the carrying capacity of the environment.  The limiting factors might be available food, 
nesting sites, number of surviving adults, predation, etc.  The population is still expanding 
exponentially because it has not yet reached carrying capacity. 

 
2. The exponential graph for year and fledglings is below. (Figure  1) 

 
 

 
 
 
 
        
 

 
Figure 1 

3. The exponential graph for the year and nests is below. (Figure 2) 
 
 

 
 

 
 
 
 
 
                                                Figure  2 
 

4. If you want to look at the equations for the line of best fit press Y= to view them.  If you want more 
manageable numbers, press MODE and select 1 or 2 decimal places before  doing the line of best 
fit calculations. 

 
5. If you want to practice sequencing with the students, this can be done in the year list.  Use the 

arrow keys to place the cursor on L1 and press 2nd LIST, arrow right to OPS, select 5:seq(  On the 
list screen add to seq(X,X,1,28,1).  The sequence format is: seq(expression, variable, begin, end, 
increment) 

 
6. IMPORTANT. The students must use year number not year because the years are beyond the 

graphing limits of the calculator screen. 
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Hey Mister, How Much is That Fish? 
 
Overview:  
Students will use math to determine the cost of raising and releas ing one brook trout into a Virginia stream. 
 
SOL Connections:  
Math: 7.18, 8.14,  
Science: 6.1, 6.7, LS.1, LS.4, LS.12 
 
Background: 
Many streams in Virginia’s mountains can no longer produce breeding populations of native brook trout. 
The riparian buffers or stream edges were destroyed by timber practices, farming or construction before 
regulations protecting these fragile ecosystems were put into place.  Without trees to shade the stream 
trout could not survive. The trees prevent silt from entering streams and provide leaf litter for insects to live 
in.  Trout require optimal water temperatures of 50-68 degrees F and a minimum dissolved oxygen content 
of 6.0 parts per million (ppm).  There must also be plenty of aquatic insects available for food.  Each year 
the Department of Game and Inland Fisheries raises or houses trout at six fish cultural stations or fish 
hatcheries in the western portion of the state.   
 
Fish are grown to catchable size in the hatchery and then placed on trucks to be transported to streams 
with suitable environmental conditions.  A list of where the trout are being stocked on any given week can 
be found on the web site  www.dgif.virginia.gov  
 
In order to fish for trout, angleers  must purchase an additional trout stamp or license for $12.50.  This 
additional charge pays for Virginia’s “put and take” trout fishery.  The effort to improve stream banks and 
riparian buffers along Virginia’s streams is a constant challenge.   With improved water conditions, brook 
trout, along with the introduced rainbow and brown trout species, will be able to reproduce naturally. 
 
Problem: 
Determine the cost of producing one trout for restocking and graphically represent the breakdown of 
operational costs for a trout hatchery. 
 
Data Table: 

Coursey Springs Hatchery Data 2004 
Data Type Amount 

Total Operating Cost $319,835.00 
      % salaries  65 
      % wages    1 
      % feed 23 
      % utilities   5 
      % vehicles   5 
      % maintenance   1 
Number of Trout released 348,013 
Pounds of Trout released 176,752 
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Key Strokes 

1. Refer to Appendix I. Calculator Set Up 
2. Press the APPS key.  Select CelSheet. Press ENTER, ENTER. 
3. Press the Menu function key to get a new cell sheet. Select 1:File. Select 3:New.  Type 

TROUT. Press ENTER, ENTER to get a blank cell sheet titled Trout. Figure 1 
 

 
 
 
 
 
 
 

Figure 1 
4. Enter data into the cell sheet. 
5. Enter categories in column A  pressing ALPHA to use the alphabetic keys (salary, wages, 

feed, utilities, vehicle, maintenance) 
6. Note: You can only choose 8 characters and categories must be in quotes. i.e. “salary” 
7. Convert the Hatchery expense percentages to decimals equivalents and enter into column B. 
8. In cell C1 enter the equation to determine the amount of dollars spent on each hatchery 

category.  With the cursor in C1 press STO ->  (for the = sign), ( Press ALPHA  B1 x Total 
Operating Cost). Press ENTER to complete the calculation and place the product in C1. 

9. To copy and paste the equation in cells C2 – C5; place the cursor in C1 press the F3 function 
key to copy; place the cursor in C2 press the F4 key to paste. Repeat the paste for C3, C4, C5. 

10. In cell D1 enter the equation to determine the amount of spent on each released trout.  With 
the cursor in D1 press STO ->  (for the = sign), ( ALPHA C1/Total number of trout released). 
Press ENTER to complete the calculation and place the product in D1. 

11. To copy and paste the equation in cells D2 – D5; place the cursor in D1 press the F3 function 
key to copy; place the cursor in C2 press the F4 key to paste. Repeat the paste for D3, D4, D5. 

12. In column E round the numbers in column D to the nearest hundredth to represent dollars and 
cents. 

13. To create a circle graph, press menu, select 4:Charts, select 7. Pie. Use the alpha and 
number keys to enter Categories, Series, and Title.  Select Number; use arrow key to place 
cursor on Draw.   See figure 2  below 

 
 

 
 

 
 
 
 

Figure 2 
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14. Press ENTER and sketch your graph below. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
Analysis Questions 

1. What is the cost to release one hatchery produced trout?  In some streams anglers are allowed to 
keep only four fish and they must be 12 inches in length.  A citizen pays $12.50 for a Fishing License 
and another $12.50 to fish for trout in stocked trout streams.  Assuming that an angler catches his/her 
limit of fish, how many days must be fished before the angler breaks even? 

 
Extensions  
1. Use the “pounds of trout released” data to create the circle graph of hatchery expenses for one pound 

of trout. 
2. Use the data table for the Montebello Hatchery to create a cell sheet and circle graph for hatchery 

expenses for one fish and one pound of fish. 
 
Data Table 

Montebello Hatchery Data 2004 
Data Type Amount 

Total Operating Cost $145,998.00 
      % salaries  48 
      % wages    8 
      % feed   8 
      % utilities   4 
      % vehicles 18 
      % maintenance 14 
Number of Trout released 141,921 
Pounds of Trout released 61,119 
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Teacher Notes – Hey Mister, How Much Is That Fish? 

   
1. See Appendix II for more information on Celsheet Apps 
2. Spread sheet screens and graph screens for the Coursey Springs Hatchery are below 
 

 
 
                  
  
 
 
 
 
Figure 1 

 
 

 
 
   
 
 

Figure  2 
 

3. The cost to raise one fish at the Coursey Springs Hatchery is $0.39 
4. Cell sheet Apps is a free application that can be downloaded from the TI website www.education.ti.com 
5. The activity can also be completed using a standard spreadsheet application. 
 
 
 
Extensions: 
1. The pounds of fish cost for Coursey Springs Hatchery spreadsheet continuation and graph. The cost 

per pound is $1.82 
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2. Montebello Hatchery spreadsheet and graph. The cost per fish, $1.02 

              
             
             
             
          
Montebello Hatchery spread sheet and graph. The cost per pound of fish $2.39    
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How Far is Home? 
 
Overview:  Tundra swans migrate long distances to their summer and wintering grounds. Students 
determine how far a swan can travel in one season. 
 
SOL Connections: 
Math:  7.8, 8.12 
Science: 6.1, LS.1, LS.11 
 
Background: 
The tundra swan is the largest species of waterfowl that travels to Virginia for the winter months.  The 
population of tundra swans dropped to dangerously low levels in the early 1900s, but the bird have 
successfully recovered throughout most of their range. 
 
During the winters of 2001 and 2002, the Virginia Department of Game and Inland Fisheries, along with our 
neighboring states, placed satellite transmitters on tundra swans in order to determine the birds migration 
route. The transmitters should last for 1.5 to 2 years, although some swans have already lost their 
transmitters along the way or were not successful in completing the migration.  It is critical to know where 
migratory species such as tundra swans migrate to so that both of their habitats, summer and winter, can 
best be managed to protect the health of the population.   
 
The tundra swans that winter along the east coast in the Chesapeake Bay region nest in tundra habitats 
across northern Canada and Alaska. The swans travel a long distance between these two locations.  
Sometimes the swans take a break along the way, either on the trip north while they wait for the spring 
thaw, or on the way south when they are with their young and need to stop and rest.  Waterfowl, such as 
geese, ducks and swans have historical staging areas where large numbers of birds gather before making 
the next portion of the trip.  These areas usually have abundant food and water supplies that can sustain a 
large flock. Swans feed on grasses, aquatic vegetation and small grains such as corn, wheat, and 
soybeans.  The U.S. Fish and Wildlife Service, the state wildlife agencies across the United States have 
established numerous Wildlife Refuges in some of these important staging areas. 
 
You can see the migration paths, nesting locations and diaries of three tundra swans that were captured 
and tagged in Virginia on the Department of Game and Inland Fisheries web site at 
http://www.dgif.virginia.gov/wildlife/swan/index.html . There are maps of other swans from previous years in 
the archived section. 
 
A data table for three of the swans during one migration cycle follows. 

Problem: 
Determine how far and how long it takes for three swans to migrate, then graph and compare their 
migration journeys. 
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Data Table: 
Swan ID 
Number 

Start Date 
Record 

End Date 
Record 

Total Days Distance 
Traveled 

Total distance 
Traveled (mi.) 

33888 4/22/03 4/30/03  388.72 mi. N  
33888 4/30/03 5/05/03  496.39 mi. N  
33888 5/05/03 5/13/03  0 mi. - resting  
33888 5/13/03 5/18/03  583 mi. N  
33888 5/18/03 9/19/03  0 mi. – nesting  
33888 9/19/03 9/27/03  1379.17 mi. S  
33888 9/27/03 11/01/03  0 mi. - resting  
33888 11/01/03 11/05/03  617.81 mi. S  

Total days  
in each 

direction

 

27 North 
44 South 

 Total 
distance 

each 
direction 

 

1468.11 miles 
North 

1996.98 miles 
South 

 

      

33894 3/29/03 4/02/03  621.69 mi. N  
33894 4/02/03 4/27/03  0 mi. - resting  
33894 4/27/03 5/05/03  376.72 mi. N  
33894 5/05/03 5/26/03  0 miles - resting  
33894 5/26/03 5/30/03  529.33 mi. N  
33894 5/30/03 9/22/03  0 mi. - nesting  
33894 9/22/03 9/30/03  1252.78 mi. S  
33894 9/30/03 12/09/03  0 mi. - resting  
33894 12/09/03 12/13/03  662.23 mi. S  

Total days  
in each 

direction

 

63 North 
79 South 

 Total 
distance 

each 
direction 

 

1527.74 miles 
North 

1915.01 miles 
South 

 

      

33893 4/04/03 4/12/03  731.66 mi. N  
33893 4/12/03 4/25/03  0 mi. - resting  
33893 4/25/03 5/03/03  328.69 mi. N  
33893 5/03/03 5/20/03  0 miles - resting  
33893 5/20/03 6/01/03  1115.04 mi. N  
33893 6/01/03 9/17/03  0 mi. -nesting  
33893 9/17/03 9/26/03  1224.28 mi. S  
33893 9/26/03 12/09/03  0 mi. resting  
33893 12/09/03 12/21/03  903.55 mi. S  

Total days  
in each 

direction

 

58 North 
84 South 

 Total 
distance 

each 
direction 

 

2175.39 miles 
North 

2127.83 miles 
South 

 



Keystrokes: 
Complete the total days column and the total miles column in the data table.  
 

To graphically represent the migration journeys of the three swans from the data table complete the 
following: 

1. Refer to Appendix I. Calculator Set Up 
2. Press STAT, Select1:Edit 
3. Clear L1. Use the arrow keys to place the cursor on L1. Press CLEAR, ENTER to clear the list.  

Repeat for L2, L3, L4, L5, L 6. 
4. Enter Total Days for swan 33888 in L1. 
5. Enter Total Distance Traveled for swan 33888 in L2. 
6. Enter Total Days for swan 33894 in L3. 
7. Enter Total Distance Traveled for swan 33894 in L4. 
8. Enter Total Days for swan 33893 in L5. 
9. Enter Total Distance Traveled for swan 33893 in L5 
10. Press 2nd STAT PLOT Select 1:Plot 1(to choose a line graph) 
11. Make selections using arrow keys to match  figure 1 
 

 
 
 
 
 
 
 

                                        Figure 1 
    
12. Press 2nd STAT PLOT, select 2:Plot 2, turn plot on, make selections using arrow keys to match 

figure 2. 
 

 
 
 
 
 
 

Figure 2 
13. Press 2nd STAT PLOT, select 3:Plot 3, turn plot on, make selections using arrow keys to match 

figure 3. 
 

 
  

 
 
 
                                                                                              Figure 3 
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14. Press ZOOM, select 9 to create a graph  
15. Press TRACE and use the arrow keys to sketch your plot below.  Remember a graph needs a 

title and labeled axes. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Analysis Questions: 
 
Looking at the table and graph, calculate the answers to the following questions. 

 
1. Which bird flew the greatest distance to their nesting grounds? 
2. Which bird made it back to Virginia the quickest in the fall? 
3. By looking at the distance traveled where would you expect each one to nest?   
4. What was the average distanced traveled during the flight North, during the flight South? 
5. What is the average distance traveled per day, assuming the birds do not stop to rest? 
6. When looking at the actual paths each swan took, one swan decided to head East before 

continuing south.  Which swan took a “side trip”?  Where did this swan go before heading  South to 
Virginia? 

7. How does the distance of each swan’s migration journey differ? 
 
 See web page to check answers http://www.dgif.virginia.gov/wildlife/swan/index.html  
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Teacher Notes – How Far Is Home: 
Data Table 

Swan ID 
Number 

Start Date 
Record 

End Date 
Record 

Total Days Distance 
Traveled 

Total distance 
Traveled (mi.) 

33888 4/22/03 4/30/03 9 388.72 mi. N 388.72 
33888 4/30/03 5/05/03 14 496.39 mi. N 885.11 
33888 5/05/03 5/13/03 21 0 mi. - resting 885.11 
33888 5/13/03 5/18/03 26 583 mi. N 1468.10 
33888 5/18/03 9/19/03 149 0 mi. – nesting 1468.10 
33888 9/19/03 9/27/03 157 1379.17 mi. S 2847.30 
33888 9/27/03 11/01/03 291 0 mi. - resting 2847.30 
33888 11/01/03 11/05/03 294 617.81 mi. S 3465.10 

Total days  
in each 

direction

 

27 North 
44 South 

 Total 
distance 

each 
direction 

1468.11 miles 
North 

1996.98 miles 
South 

 

      

33894 3/29/03 4/02/03 5 621.69 mi. N 621.69 
33894 4/02/03 4/27/03 30 0 mi. - resting 621.69 
33894 4/27/03 5/05/03 38 376.72 mi. N 998.41 
33894 5/05/03 5/26/03 59 0 miles - resting 998.41 
33894 5/26/03 5/30/03 63 529.33 mi. N 1527.70 
33894 5/30/03 9/22/03 177 0 mi. - nesting 1527.70 
33894 9/22/03 9/30/03 185 1252.78 mi. S 2780.60 
33894 9/30/03 12/09/03 225 0 mi. - resting 2780.60 
33894 12/09/03 12/13/03 229 662.23 mi. S 3442.80 

Total days  
in each 

direction

 

63 North 
79 South 

 Total 
distance 

each 
direction 

1527.74 miles 
North 

1915.01 miles 
South 

 

      

33893 4/04/03 4/12/03 9 731.66 mi. N 731.66 
33893 4/12/03 4/25/03 22 0 mi. - resting 731.66 
33893 4/25/03 5/03/03 30 328.69 mi. N 1060.40 
33893 5/03/03 5/20/03 47 0 miles - resting 1060.40 
33893 5/20/03 6/01/03 59 1115.04 mi. N 2175.40 
33893 6/01/03 9/17/03 137 0 mi. -nesting 2175.40 
33893 9/17/03 9/26/03 146 1224.28 mi. S 3399.70 
33893 9/26/03 12/09/03 220 0 mi. resting 3399.70 
33893 12/09/03 12/21/03 232 903.55 mi. S 4303.30 

Total days  
in each 

direction 

58 North 
84 South 

 Total 
distance 

each 
direction 

2175.39 miles 
North 

2127.83 miles 
South 

 



 Virginia Department of Game and Inland Fisheries - 2005 40 

v Swan 33893 flew farthest to its nesting ground.  Tundra swans nest in Canada and Alaska. 
v Swan 33888 flew back to Virginia the fastest 
v For the three swans on the data table, the average distance flown North is 1724 miles; the 

average distance flown South is 2013 miles. 
v Swan 33888 headed East before heading South on the return migration trip 
 
Maps are available on line at www.dgif.virginia.gov  

 
Average Distance Flown per Day 

Swan North (mi./day) South (mi./day) Total Trip 
(mi./day) 

33888 54 45 50 
33894 75 24 50 
33893 37 25 31 

 
 
1. The line graph of the 3 swan migrations below 
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Let’s Talk Deer    
 

Overview:  The quality of habitat has an affect on the overall size and health of individual deer.  
Students graph antler size and infer the relationship between antler growth and habitat quality of two 
Virginia counties. 
 
SOL Objectives: 
Math 7.18, 8.12  
Science 6.9, LS.1, LS.9, LS.10, LS.11, LS.12 
 
Background:  
Deer had disappeared from western Virginia at the turn of the 20th century.  Unregulated hunting and the 
loss of habitat had eliminated a large portion of the herd.  The Department of Game and Inland Fisheries 
began restoration of the deer herd in 1931 by capturing deer in other states and releasing them in Virginia 
until 1950. Restocking began again in the late 1960s and early 1970s with deer from established herds 
within Virginia. 
 
Without any controls on the population, a deer herd will quickly fill the available habitat. Habitat is more 
than just the piece of land that the deer occupy.  Although there must be ample food, water and shelter in 
the habitat, the quality of those key components will determine the actual number and health of the animals 
in the area.  The habitat quality in Frederick County is better than the habitat in Caroline County.  Frederick 
County has richer soils that are limestone based and will grow better vegetation that deer need.  Frederick 
County also has more farms which means the availability of more crops and orchards, a favorite food 
source for deer.  In contrast the soil in Caroline County is an acidic mix of sand and clay.  Such soils do not 
support optimal deer habitat. Factors like habitat quality which can affect a population are called limiting 
factors and normally exert some control over herd numbers and growth vigor.  
 
Each year, several measurements are recorded from the deer hunted in each county and the numbers are 
analyzed by the Virginia Department of Game and Inland Fisheries.  The antler beam diameter, number of 
points, and outside spread are measured.  We can use the size of the antler beam to infer the size of the 
deer. 
 
Problem:   
How does antler growth compare between two different deer hears in Caroline County and Frederick 
Count? Which county “grows” healthier deer? 
 

--------Outside Spread ----- 
 

   One Point---------- 
 
    Antler Beam---------  
   (diameter) taken one  
   inch above burr 
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Data table 
    Yearling (1.5 yrs) Antler Data for Caroline and Frederick Counties in 2000 

Harvest Date No Points Beam Diameter in mm Outside Spread  in inches County Name 
17-Nov-00 2 10 6.00 Caroline 
24-Nov-00 4 20 16.25 Caroline 
17-Nov-00 4 19 7.25 Caroline 
22-Nov-00 2 14 4.25 Caroline 
20-Nov-00 5 14 8.00 Caroline 
10-Nov-00 3 20 6.00 Caroline 
06-Nov-00 2 14 7.00 Caroline 
17-Nov-00 2 10 6.00 Caroline 
20-Nov-00 5 14 8.00 Caroline 
20-Nov-00 4 16 6.00 Caroline 
20-Nov-00 2 13 9.25 Caroline 
22-Nov-00 2 14 4.25 Caroline 
20-Nov-00 3 16 9.25 Caroline 
24-Nov-00 3 17 9.00 Caroline 
24-Nov-00 2 15 6.50 Caroline 
24-Nov-00 2 19 9.00 Caroline 
24-Nov-00 2 12 15.00 Caroline 
11-Nov-00 3 8 9.25 Caroline 
22-Nov-00 4 19 9.00 Caroline 
24-Nov-00 5 15 6.00 Caroline 
25-Nov-00 3 10 8.00 Caroline 
25-Nov-00 2 13 6.00 Caroline 
06-Nov-00 2 14 6.75 Caroline 
17-Nov-00 2 18 6.88 Caroline 
20-Nov-00 3 16 8.50 Caroline 
15-Nov-00 3 16 15.50 Frederick 
20-Nov-00 2 16 7.13 Frederick 
20-Nov-00 5 20 10.50 Frederick 
25-Nov-00 4 17 20.00 Frederick 
25-Nov-00 2 14 5.25 Frederick 
17-Nov-00 3 16 6.50 Frederick 
13-Nov-00 4 16 7.00 Frederick 
20-Nov-00 2 10 6.00 Frederick 
16-Nov-00 2 14 7.00 Frederick 
14-Nov-00 8 17 9.00 Frederick 
25-Nov-00 2 12 7.50 Frederick 
20-Nov-00 5 16 7.13 Frederick 
20-Nov-00 4 15 9.38 Frederick 
20-Nov-00 2 13 4.00 Frederick 
20-Nov-00 4 16 9.38 Frederick 
20-Nov-00 6 26 11.38 Frederick 
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Harvest Date No Points Beam Diameter in mm Outside Spread  County Name 
20-Nov-00 4 19 6.50 Frederick 
25-Nov-00 7 20 10.63 Frederick 
24-Nov-00 2 10 3.50 Frederick 
15-Nov-00 7 29 14.25 Frederick 
25-Nov-00 7 26 11.50 Frederick 
25-Nov-00 6 25 10.38 Frederick 
20-Nov-00 4 16 4.00 Frederick 
20-Nov-00 4 15 4.00 Frederick 

 
Question: 
Does habitat affect the size of antlers in deer yearlings? 
 
Key strokes 
 

1. Refer to Appendix I. Calculator Set Up 
2. Press STAT , Select 1:Edit, Press ENTER 
3. Clear L1. Use the arrow keys to place the cursor on L1, Press  CLEAR, ENTER to clear the list.  

Repeat for L2. 
4. Enter Deer Beam Diameter for Caroline County in L1. 
5. Enter Deer Beam Diameter for Frederick County in L2. 
6. Press 2nd STAT PLOT. Select Plot 1, Select ON and Box and Whisker Plot with outliers. 

7. Make selections using arrow keys to match  figure 1 
 

 

 

 

 

Figure 1 
 

8. Press ZOOM, 9 to create a box and whisker plot with outliers.  Press TRACE and use the 
arrow keys to determine: 

Min: ______________           3rd Quartile: __________ 

1st Quartile: ________         Outliers: ____________ 
Med:______________         Max: ______________ 
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9.  Press 2nd STAT PLOT?, select 2:Plot 2, turn plot on, make selections using arrow keys to 
match figure 2    

     
     
 
  
 
 
                                             

                                                      Figure 2                                

10. Press ZOOM 9 to graph 
 
11. Press TRACE and use the arrow keys to show the quartile and median values for each box 

and whisker plot. 
 

Caroline County   Frederick County    
Min:_________   ___________    
Q 1: _________   ___________    
Med: ________    ___________    
Q 3: _________   ___________    
Max: ________   ___________    

 
 
12. Sketch your plot below. Remember a graph needs a Title and Axes Labels. 
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13. To determine the modes for Lists 1 and 2.  Press STAT, Select 3: Sort D and add L1, L2,. See 
Figure 4 below. 

 
 
 
 
 
 
 
 

 
Figure 4 

 
14. Press STAT select 1:Edit, press ENTER 
15. Review Lists 1 and 2 to identify the modes 
16. List the modes for each time span:  
17. Caroline County Deer Beam Diameter________________  
18. Frederick County Deer Beam Diameter _______________ 

 

Analysis questions: 

1. Using the beam diameter data, which measure of central tendency best describes the average size 
deer for each county? 

 
 
2. In which quartile do the majority of the deer fall for each county? 
 
 
3. Are there any outliers, and if so, what are they? 
 
 
4. Are the deer in one county statistically larger than the deer in the other county?  What might explain 

this? 
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Teacher Notes – Lets Talk Deer: 
 

1. The size of deer as inferred from its antler beam diameter is statistically larger in Frederick 
County than in Caroline County.  See figure 1. 

 
 
 
 
 
 
 

 
 

Figure 1 
2. The deer population in Frederick County has one Outlier.  The mode for Caroline County is 14 

mm and the mode for Frederick County is 16 mm. 
 
 

3. You can explore further statistics by pressing STAT, arrow right to CALC and selecting 1: 1-
Var Stats. Then add the list you wish to be analyzed. See figure 3 and figure 4. 

 
 
 
 
 
 
 
 
 

Figure 3                                                                           Figure 4 
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Let’s Talk Turkey  
Overview:   
All wildlife species, including turkey, are dependent upon their habitat.  The biotic (living) and abiotic (non-
living) factors in the ecosystem have an influence on the survival of young and adult turkeys.  In years 
when oak trees do not produce abundant acorns, fall or winter survival may be limited to those birds that 
can find enough additional food sources to replace the calories obtained from acorns. 

SOL Connections: 
Math 7.18, 8.12  
Science: LS.1, LS.7, LS.9, LS.11 

Background: 
Wild turkeys were abundant in colonial times and were a major source of food for early Virginians. Loss of 
habitat in the early 1900’s caused a large decline in Virginia’s turkey population. Turkeys can now be found 
throughout the state after an extensive recovery plan that began in the early 20th century. The population of 
wild turkeys in Virginia numbers around 180,000 birds. 
 
The Department of Game and Inland Fisheries continuously monitors the ratio of adult to juvenile turkeys 
and male to female turkeys in order to maintain a stable population.  To assist biologists in determining this 
ratio, fall turkey hunters turn in a breast and wing feather from each bird harvested.  This provides the 
biologists with a random sample of the overall population. 
 
Turkeys feed on a variety of plants and insects during the year. During the fall, acorns make up a large part 
of their diet.  Biologists call the fall fruit, nut and berry production “mast”.  Hard mast is made up of hickory 
nuts, walnuts and acorns.  Soft mast is made up of berries on holly, honeysuckle, blueberries and other soft 
fruits.  By surveying the amount of mast available, biologists have an idea of how many young animals will 
have enough food to get them through the winter. Each year biologists count the number of acorns on each 
limb of a sample plot of oak trees to determine the relative abundance of mast. Oak trees tend to produce 
large number of acorns every two to three years.  Spring rains, wind and the amount of summer rainfall can 
also have an effect on the number of acorns available to turkeys. 
 
An important factor that influences the ratio of juvenile s to adults is the amount of rain each spring.  
Turkeys are ground-nesting birds, and heavy rains will flood out their nests, forcing the hens to begin a new 
clutch or nest of eggs again.  Second or even third clutches are usually smaller then the original clutch. 
Biologists look at this and many other limiting factors to determine the health of wildlife populations.  In this 
activity we will only look at the mast count. 
 
 
Problem:  
How does the abundance of an acorn crop influence the population of young wild turkeys that survive each 
year? 
 
 
 
 



 Virginia Department of Game and Inland Fisheries - 2005 48 

Data table 
Wild Turkey Age and Sex Composition from Fall Harvest Feather Collections in Virginia. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Year Year 
Number 

% Juvenile % Adult 
Female 

% Adult Male Sample Size 
Total of all 

birds 
1984 1 60.9 18.6 20.5 4,483 
1985 2 61.3 17.2 21.4 5,270 
1986 3 64.6 16.4 19.0 5,447 
1987 4 63.6 16.1 20.3 6,599 
1988 5 61.9 17.3 20.8 4,877 
1989 6 66.3 15.8 17.9 6,289 
1990 7 52.0 21.9 26.1 6,986 
1991 8 63.0 17.4 19.6 4,474 
1992 9 51.1 21.0 27.9 4,421 
1993 10 65.1 16.8 18.1 4,329 
1994 11 60.4 17.2 22.4 5,011 
1995 12 58.9 19.0 22.0 3,638 
1996 13 54.9 18.7 26.4 3,650 
1997 14 45.4 24.3 30.3 3,235 
1998 15 43.3 26.0 27.7 1,924 
1999 16 56.4 24.3 30.3 1,899 
2000 17 55.3 18.7 26.0 1,870 
2001 18 48.3 21.6 30.1 2,815 
18 yr. 
avg. 

 57.5 19.1 23.3  

5 yr 
avg. 

 50.3 22.1 27.5  
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Virginia Oak Mast Survey Ratings 
Mean Number of Acorns per limb 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The acorn count is collected each year by physically counting the number of acorns on selected limbs on 
selected trees.  Biologists use binoculars to see the acorns and calculate the average number in their area.  
The number above is a state wide average combining the eastern and western count. 
 
Key strokes 

1. Refer to Appendix I. Calculator Set Up 
2. Press STAT, Select 1:Edit 
3. Clear L1. Use the arrow keys to place the cursor on L1. Press CLEAR, ENTER to clear the list.  

Repeat for L2, L3 
4. Enter year number from the first table in L1. 
5. Enter percent of juveniles in L2. 
6. Enter state acorn average data from the second table in L3 
7. Press 2nd STAT PLOT Select 1:Plot 1(to choose a line graph) 

 
 

Year 
Number 

Year Avg. # per 
limb 

1 1984 16.8 
2 1985 36.5 
3 1986 15.6 
4 1987 2.8 
5 1988 24.0 
6 1989 26.6 
7 1990 10.2 
8 1991 22.1 
9 1992 8.9 

10 1993 17.9 
11 1994 18.5 
12 1995 21.0 
13 1996 20.5 
14 1997 7.2 
15 1998 17.1 
16 1999 18.8 
17 2000 18.4 
18 2001 26.6 

   
 Total 329.5 
 # years 18 
 Mean 18.3 
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8. Make selections using arrow keys to match  figure 1 
 
 
 
 
 
 
 
 

 
                                        Figure 1  
   
9. Press 2nd STAT PLOT, select 2:Plot 2, turn plot on, make selections using arrow keys to match 

figure 2 
 

 
 
 
 
 
 
 

Figure 2 
 

10. Press ZOOM, select 9 to create a graph  
 
11. Press TRACE and use the arrow keys to sketch your plot below.  Remember a graph needs a 

title and labeled axes. 
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Analysis Questions 
1. Is there a correlation between decreases in juvenile turkey populations and acorn mast for the year? 

Use examples from your graph to support your answer. 
 
 
 
 
 
 
2. Are there years when acorn mast and juvenile turkey populations are not correlated?  What might be 

other factors that would affect juvenile turkey populations? 
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Teacher Notes – Talk Turkey: 
 
1. There is a correlation between acorn mast and juvenile turkey populations for years 6 through 14.  See 

figure 1. 
 
 
 
 
 
 
 
 
 

Figure 1 
 
2. There is no correlation between acorn mast and the juvenile turkey population for year 3, 15, and 18.  

This could be due to climate, other food sources or predation. 
 
 
 
3. If you want to practice sequencing with the students, this can be done in the year list.  Use the arrow 

keys to place the cursor on L1 and press 2nd LIST, arrow right to OPS, select 5:seq(  On the list screen 
add to seq(X,X,1,18,1).  The sequence format is: seq(expression, variable, begin, end, increment) 
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Turkey Families 
 
Overview:  
Wild turkeys can be aged and sexed by their feathers.  Using feather information collected by hunters, 
students will determine the ratio of adult to juvenile birds harvested. 
 
SOL Connections:  
Math: 7.18, 8.12 
Science: 6.1, LS.1, LS.4, LS.7 
 
Background: 
Wild turkeys were abundant in colonial times and were a major source of food for early Virginians. Loss of 
habitat in the early 1900’s caused a large decline in Virginia’s turkey population. Turkeys can now be found 
throughout the state after an extensive recovery plan that began in the early 20th century. The population of 
wild turkeys in Virginia numbers around 180,000 birds. 
 
The Department of Game and Inland Fisheries continuously monitors the ratio of adult to juvenile turkeys 
and male to female turkeys in order to maintain a stable population.  To assist biologists in determining this 
ratio, fall turkey hunters turn in a breast and wing feather from each bird harvested.  This provides the 
biologists with a random sample of the overall population.  
 
Breast feathers from female turkeys are brown on the tip and the edge is ragged. Male breast feathers 
have a black tip with a smooth edge.  To determine the age of the turkey, biologists look at a primary or 
wing feather. Pointed primaries without white barring or stripes on the tip come from juvenile birds.  
Rounded primaries with barring to the end of the feather are adults.  A color graphic of the methods used to 
age turkeys can be viewed at http://www.dgif.virginia.gov/hunting/va_game_wildlife/index.html. 
 
Problem:   
What is the correlation between the numbers of juveniles and the numbers of adult birds over several 
years?  Does the ratio of adult to juvenile turkeys remain stable over a period of years? 
 
 
Data table: Wild turkey age and sex composition from fall harvest feather collections in Virginia. 

Year Year 
Number 

% Juvenile % Adult 
Female 

% Adult Male Total of birds 
sampled 

1984 1 60.9 18.6 20.5 4,483 
1988 5 61.9 17.3 20.8 4,877 
1992 9 51.1 21.0 27.9 4,421 
1997 14 45.4 24.3 30.3 3,235 
2001 18 48.3 21.6 30.1 2,815 
18 yr. 
ave. 

 57.5 19.1 23.3  
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Key Strokes 
1. Refer to Appendix I. Calculator Set Up 
2. Press the APPS key.  Select CelSheet. Press ENTER, ENTER. 
3. Press the Menu function key to get a new cell sheet. Select 1: File. Select 3: New. Type 

TURKEY. Press ENTER, ENTER to get a blank cell sheet titled Turkey. See fig.1 
 

 
 
 
 
 
 
 

Figure 1 
 

4. Enter data into the cell sheet. 
5. Enter categories in Row 1  pressing ALPHA to use the alphabetic keys (year, male, female, 

young) 
6. Note: You can only choose 8 characters and categories must be in quotes. i.e. “year” See 

figure 2 
 
 
 
 
 
 
 
 

Figure 2 
 

7. Enter the years for the turkey data in Column A 
8. Enter the percentages of males in Column B 
9. Enter the percentages of females in Column C 
10. Enter the percentages of young in Column D 
11. To create a bar graph, press menu, select 4:Charts, select 5. Bar Use the alpha and number 

keys to enter Categories, Series, and Title.  Select Number; use arrow key to place cursor on 
Draw.   See figures  3 &  4  below 

 
 
 
 
 

 
 
 
 
Figures 3 & 4 
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12. Press ENTER and sketch your graph below. (Remember a graph needs a title and labeled  

axes)  Press TRACE and use the arrow keys to analyze the graph.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Analysis Questions 
1. How do the numbers of males, females, and young compare within the populations of turkeys 

graphed? 
 
2. Is there any variation in the population make up of males, females, and young in the turkey populations 

among the years graphed? 
 
 
Extensions  
3. Use the percentages and the sample size to determine and graph the number of males, females, and 

young for the populations of turkeys. 
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Teacher Notes – Turkey Families: 
   

1. See Appendix II for more information on Celsheet Apps 
 

2. Spread sheet screens and graph screens for the Turkey Populations are below 
 
 

 
 

 
 
 
 

 
Figure 1 
 

 
 

 
 
 

 

Figure 2 
 
 

3. Pressing the TRACE key and using the arrow keys will indicate that adult males always 
outnumber the adult females but are close to being equal percentages in the population.  The 
greatest variation is in the young: some years there are more young than adults; some years 
the percentages of young and adults are about equal; and some years the adults outnumber 
the young. 

 
4. Cellsheet Apps is a free application that can be downloaded from the TI website 

www.education.ti.com 
 

5. Activity can also be completed using a standard spreadsheet application. 
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Who Just Swam By? 
 

Overview: 
Students will analyze the data collected from observations of fish that swim past the viewing window at the 
Bosher’s Dam Fishway. 

SOL Connections: 
 Math 7.18, 8.14, A.7, A.8 
Science 6.1, 6.7, LS.1, LS.11, LS.12 
 
Background: 
Two hundred years ago the need for hydropower resulted in the construction of dams on the James River. 
The water running over the dams produced the power needed to run the mills that supported the Richmond 
economy.  The dams also blocked anadromous, or migratory, fish from reaching their historic spawning or 
breeding grounds upriver. Anadromous fish hatch in freshwater, and then swim out to the ocean where they 
grow and mature. When it is time to spawn, or reproduce, they return to the rivers and streams where they 
hatched years before. 
 
Because the construction of dams reduced the number of uninterrupted linear miles between the ocean 
and the freshwater spawning grounds, the populations of American Shad and other species of mig ratory 
fish eventually declined.  In an effort to recover these species the dams had to be altered.  Since most were 
no longer in use, they were either removed or had small notches cut into them that the fish could swim 
through.  The largest dam in Richmond and the last to be altered on the James River was Bosher’s Dam.  
Because this dam was still in use, it could not be completely removed. Instead a fishway was placed in the 
dam.  A fishway is a ladder-like system that directs water flow from one side of the dam to the other. To 
check on the effectiveness of the fish way, an observation window was constructed in order for biologists to 
watch the fish swim by. 
 
During the migratory season, a video camera records all fish that swim past the viewing window.  You can 
view the fish by visiting www.dgif.virginia.gov and clicking on “Fishing” and then “Shad Cam”.  The “Shad 
Cam” is live only during those spring months when fish are migrating. 
 
American Shad is the target species for recovery since it is a valuable species in the Chesapeake Bay 
ecosystem.  Other species of anadromous fish also use the fish way on their migration routes.  In addition, 
freshwater species also use the fishway on their daily travels, including sunfish, large mouth bass and carp.  
Occasionally, a river otter will swim through in search of a dinner.  
 
Problem: 
Do any trends exist in numbers of fish swimming up the James River in a four year period? 
In which species do you see a trend in the numbers?   
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Data table: 
BOSHER OBSERVATION WINDOW DATA 

 
Fish Species 1999 2000 2001 2002 

American Shad 185 375 697 1066 
Sunfish 1498 646 987 1184 

Hogsucker 152 20 4 0 
 
Key strokes: 
 

1. Refer to Appendix I. Calculator Set Up 
2. Select EDIT (1) 
3. Clear L1. Use the arrow keys to place the cursor on L1. Press CLEAR, ?ENTER ?to clear the 

list.  Repeat for L2, L3, L4 
4. Enter year data into L1 
5. Enter shad data in L2 
6. Enter sunfish data in L3 
7. Enter hogsucker data in L4 (see figure 1) 

 
 
 
 
 
 
 
 

Figure 1 
 

8. Press 2nd, Y=, ENTER (to select 1. Plot 1) to choose a scatter plot 
9. Make selections using arrow keys to match  figure 2 

 
 
 
 
 
 
 
 
 

Figure 2 
10. Press ZOOM 9  
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11. Sketch your graph on the axis below using TRACE and the arrow keys to find the coordinates 
of your data points.  Remember a graph needs a Title and Axes Labels.  

 
 
 
 

 
 
 
 

 
 
 
12. Record any trends in the shad data 
13. Press 2nd , Y=, select 2:Plot 2, turn plot on, make selections using arrow keys to match figure 3 

 
 
 
 
 
 
 
 

Figure 3 
 
 

14. Press ZOOM, select 9 
15. Press 2nd, Y=, select 3:Plot 3, turn plot on, make selections using arrow keys to match figure 4 

 
 
 
 
 
 
 
 

                                 Figure 4      
 
16. Press ZOOM, select 9 
17. Record trend if any for each species 

 
Analysis questions: 
1. Based on the definition of anadromous fish, which species is most likely to be anadromous and why? 
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Extensions:  Graph species from the table below and determine if any trends exist. 
 

 MORE BOSHER OBSERVATION WINDOW DATA 
 

 
 
 
 
 
 

FISH SPECIES 1999 2000 2001 2002 
Longnose gar 70 93 241 127 

Channel catfish 671 835 1,100 201 

Quillback 3,974 6,333 4,848 4,848 

Flathead catfish 0 23 73 11 
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Teacher Notes – Who Just Swam By? 
1. The scatter plot shows a trend of increase for the American Shad, indicating that the population 

may be increasing.  The Department’s efforts are successful as the American Shad is recovering. 
 
        
        
        
        
        
        
         
 
Students can check for the linear regression line by: 
Press STAT, arrow right to CALC, select 4:LinReg(ax+b) 
Press 2nd L1 , 2nd L2 , VARS, Y-VARS, and select 1:Function, 1:Y1 
Press ENTER 
Press ZOOM, select 9 to show the linear trend 
        
       
 
 
 
 
 
 

2. The scatter plots for the Sunfish and Hogsucker do not show any trends 
 
 
 
 
 
 
 
 

                      Sunfish                                                                  Hogsucker 
 

3. The fish on the extension also do not show any trends. 

Longnose Gar              Channel Catfish  Quillback          Flathead Catfish 
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APPENDIX 1 
Calculator Set Up 

 
Before using the calculator to record and analyze data and create a graph of that data, it is recommended 
these steps be followed. It is wise to complete the following steps. 

 
1. Press 2nd QUIT and CLEAR to clear the home screen 
 
2. Press Y=.  Place the cursor on any equations and press CLEAR to remove them. 
 
3. Press 2nd STAT PLOT. Select 4: Plots Off. Press ENTER to get the message DONE on the home 

screen that all plots have been turned off. 
 
4. Press MODE.  Usually all options to the left should be highlighted.  Be sure the mode is set correctly for 

the activity. 
 
5. Press 2nd FORMAT. Usually all options to the left should be highlighted.  Be sure the mode is set 

correctly for the activity. 
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APPENDIX 2 
TI-83 Plus Cell Sheet.Application 

 
How To… 
Enter data Edit data 
Create charts Import and export data 
Examples 
Scatter chart Bar chart 
Pie chart Linear regression 
 
­You can download a free copy of the latest operating system software from 
www.education.ti.com/softwareupdates.  
Follow the link to Operating Systems. 
 
Quick Reference Guide  
• Starting the Application  1. Press APPS, and then select CelSheet. The information 

screen is displayed. 
2. Press any key to continue. The CellSheet™ help screen is displayed. 
3. Press any key to continue. 
 

• Quitting the Application  1. From the main spreadsheet screen, press GRAPH (Menu) or 
2nd QUIT. 
2. From the CELLSHEET MENU, select Quit CellSheet. 
 

• Deleting the Application  1. Press 2nd MEM to display the MEMORY menu. 
     from Your Calculator  2. Select Mem Mgmt/Del. 

3. Select Apps. 
4. Move the cursor to CelSheet. 
5. Press DEL. A confirmation message is displayed. 
6. Select Yes to delete the application. 
 

Completing Tasks   Task Instructions 
• Enter a value in a cell 1. Enter the value, and then press ENTER. 
 
• Enter text or a numeric  1. Press ALPHA then press “. 

string in a cell  2. Enter the text. 
3. Press “  then press ENTER 

 
• Create a formula   1. Press STO-> 

2. Enter a formula. 
3. Press ENTER. 
 

• Use a variable in a  1. From the TI_83 Plus home screen, store a value 
Spreadsheet  to a variable (for example, 5 STO-> X). 

2. Start the CellSheet™ application, and open the spreadsheet file. 
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3. Move the cursor to a cell and type the variable (such as X). Do not 
surround the variable with quotation marks. 
4. Press ENTER The variable's value appears in the cell. 

 
• Switch between the  1. Select Menu, select Charts, and then select the 

spreadsheet and a  chart you want to display. 
chart or graph  2. To return to the spreadsheet, press 2nd QUIT 

• Delete a row or  1. Move the cursor to the row header or column 
column    header to select the row or column. 

2. Press DEL The columns to the right of the deleted column 
shift left.  The rows below a deleted row shift up. 

 
• Clear data from a  1. Select one or more cells, a row, or a column. 

cell, cell range, row,  2. Press CLEAR. 
or column 

 
• Cut, copy, and paste To cut or copy a cell: 

1. Move the cursor to the cell. 
2. Press WINDOW cut the cell.—or—Press FORMAT copy the cell. 
To paste: 
1. Cut or copy one or more cells. 
2. Move the cursor to the new cell (or the first cell of a new cell range). 
3. Select Paste press TRACE 

 
CellSheet Main Menu  
1. To display the CELLSHEET MENU, select Menu (press GRAPH). 
2. To display a help screen for common tasks, select Help from the CELLSHEET MENU. 
3. To exit the application, select Quit CellSheet from the 
CELLSHEET MENU. 
4. Press 2nd QUIT­Return to the main menu from a submenu 

        ­Return to the spreadsheet from the main menu 
File Menu 
Menu Item Description 
1: Open Opens an existing spreadsheet file. 
2: Save As Saves the current spreadsheet with a different name. 
3: New Creates a new spreadsheet and lets you enter a unique name. 
4: Delete Deletes a spreadsheet. You cannot delete the currently open spreadsheet. 
5: Format Lets you set up formatting options such as automatic recalculation, cursor movement, help 
screen display, and edit line display. 
6: Recalc Recalculates the spreadsheet (only needed when the auto calculation feature in the Format 
menu is turned off) 
Edit Menu 
Menu Item Description 
1: Go To Cell Moves the cursor to a specific cell. 
2: Undelete Cell Retrieves the contents of the cell that you just deleted or cleared. 
3: Clear Sheet Deletes all data from the current spreadsheet. 
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4: Select Range Selects a range of cells. 
5: Cut Cuts the contents and formulas from the currently selected cell or range of cells and places them on 
the clipboard. 
6: Copy Copies the contents and formulas from the currently selected cell or range of cells and places them 
on the clipboard.  
7: Paste Pastes the contents and formulas that were just cut or copied to the clipboard into the current cell.  
Options Menu 
Menu Item Description 
1: Statistics Calculates 1-variable statistics, 2-variable statistics, or linear regression for the currently 
selected cell range. 
2: Fill Range Fills a range of cells with a formula, number, or text. 
3: Sequence Fills a range of cells with a sequence of numbers. 
4: Import/Export Imports lists or matrices, or variables; exports lists, matrices, or variables. 
5: Sort Sorts a range of cells in ascending or descending order. 
6: Col Decimal Sets the decimal mode display for a column. not affect the CellSheet™ application. 
Charts Menu 
Menu Item Description 
1: Scatter Displays a scatter chart for a range of cells. 
2: Scatter Window Displays the parameters for the viewing window for the scatter chart so that you can 
change the values. 
3: Line Displays a line chart for a range of cells. 
4: Line Window Displays the parameters for the viewing window for the line chart so that you can change 
the values. 
5: Bar Displays a bar chart for a range of cells. 
6: Bar Window Displays the parameters for the viewing window for the bar chart so that you can change the 
values. 
7: Pie Displays a pie chart for a range of cells. 
Creating, Saving, and Opening Files  
Creating a File  
To create a new, blank spreadsheet: 
1. Select Menu (press APPS) to display the CELLSHEET MENU. 
2. Select File 3. New. 
3. Enter a name for the new spreadsheet, and then press ENTER two times. A new, blank spreadsheet is 
displayed. 
Tip The spreadsheet name 
• can contain numbers and letters, but must begin with a letter 
• can contain up to 8 characters 
• TICSFILE is a reserved name used by the CellSheet™ application. 
Saving a File  
The spreadsheet is automatically saved in RAM as you work. 
You do not have to manually save your work. However, you can save the current spreadsheet with a new 
file name. 
To save a file with a new name: 
1. Select Menu (press GRAPH). 
2. Select File > Save As. 
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3. Enter a name for the new spreadsheet, and then press ENTER two times. The spreadsheet is displayed, 
and the first four characters of the new name are displayed in the top left cell. 
Opening a File  
1. Select Menu (press GRAPH). 
2. Select File, and then select Open. A list of spreadsheet file names is displayed. 
3. Move the cursor to the spreadsheet name that you want to open, and then press ENTER. 
Tip : Only one spreadsheet can be open at a time. 
Names of archived spreadsheets do not appear in the list. You must unarchive a spreadsheet before you 
can open it. 
Managing Files  
Copying a File 
To copy a spreadsheet file, save the file with a new name. 
Deleting a File 
1. Select Menu (press GRAPH). 
2. Select File > Delete. 
3. Move the cursor to the spreadsheet file name that you want to delete, and then press ENTER. 
Note You cannot delete the spreadsheet that is currently open. 
4. Select Yes. The spreadsheet file is deleted. 
Renaming a File 
To rename a file, save the file with a new name, and then delete 
the old spreadsheet. 
Using CellSheet Commands  
The CellSheet™ application displays commands at the bottom of 
the screen at various times to help you complete specific tasks. 
To select a command, press the graphing key directly below the 
command. 
Entering Spreadsheet Data  
1. A numeric value, text string, or formula that is entered into a single cell can contain a maximum of 40 
characters. 
2. Numeric values are right-justified in the cell; text is left justified. 
3. The number of characters that are displayed is limited by the column decimal format for numeric values, 
and by the contents of the adjacent cell(s) for text. The edit line displays the entire contents of the cell. 
4. The displayed value of the cell is rounded to the number of decimal places specified by the column 
decimal format. However, the actual value of the cell is used in calculations. 
5. Cells that contain text are treated as if they contained the value 0 when they are referenced in math 
operations, statistics, or charts. 
6. Cells that contain text are ignored when they are referenced in cell ranges that are used in formulas. 
Entering a Formula  
A formula is an equation that performs operations on spreadsheet data. Formulas can: 
7. Perform mathematical operations, such as addition and multiplication 
8. Compare worksheet values 
9. Refer to other cells in the same spreadsheet 
When you use a formula, the formula and the evaluation of the formula are both saved in the cell. 
The following example adds 15 to the value in cell C4 and then divides the result by the sum of the values 
in cells B4, B5, and  B6. 
=(C4+15)/sum(B4:B6) 
To enter a formula, press ¡to place an equal sign on the edit line, and then enter the formula. 
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Entering a Function  
A function is a predefined formula that performs calculations by using specific values in a particular order. 
The values are called arguments. The arguments can be numbers, lists, cell names, cell ranges, etc., 
depending on what the function requires. The arguments are enclosed in parentheses, and a comma 
separates each argument. 
=sum(A3:A25)     Note The ending parenthesis is required! 
1. When a function uses a cell name or range as arguments, it must be preceded by an equal sign; 
otherwise, no equal sign is necessary. 
2. When the function is not preceded by an equal sign, only the resulting value of the function is saved in 
the cell; the entire function and its arguments are not saved. 
3. If a function's argument is a list, a cell range is also a valid argument. 
4. If a function's argument is a value, a cell name is also a valid argument. 
To enter a function: 
1. Press STO-> to place the equal sign on the edit line, if necessary. 
2. Press GRAPH display a list of commonly used functions, move the cursor to a function, and then press 
ENTER to select it. 
—or— 
Select a function from the calculator catalog or other menus, such as Math, List, or Test. 
3. Enter the argument(s) for the function, and then press ENTER.  
dit). 
Editing Spreadsheet Data  
• Editing Cell Contents  
You can change a cell's contents by entering a new text string, value, or formula in place of the existing 
one. If you want to edit the existing contents, move the cursor to the cell that you want to edit, and then 
press ENTER. The cursor moves to the edit line at the bottom of the screen. You can use the arrow keys to 
move the cursor to the part of the entry that needs to be changed. 

Using the Tools on the Options Menu  
Analyzing Data  
Note - When you perform statistics or a linear regression on a range of cells, empty cells in the range are 
treated as if they contained the value 0. 
You can select a range on which to perform statistics before you select the statistics type. The range is 
automatically entered at the appropriate prompts. 
Performing 1-Var Statistics 
1. Select Menu, and then select Options > Statistics > 1-Var  Stats. 
2. Enter the range for the calculation at the Range prompt. 
3. Press ENTER two times to perform the calculation. 
Performing 2-Var Statistics 
1. Select Menu, and then select Options > Statistics > 2-Var Stats. 
2. Enter the first range for the calculation at the 1st Range prompt, and then press ENTER. 
3. Enter the second range for the calculation at the 2nd Range prompt. 
4. Press ENTER two times to perform the calculation. 
Performing a Linear Regression 
1. Select Menu, and then select Options > Statistics > LinReg(ax+b). 
2. Enter the range for the x-variable at the XRange prompt. 
Tip Press ENTER to move the cursor to each subsequent prompt. 
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3. Enter the range for the y-variable at the YRange prompt. 
4. If necessary, enter the range for the frequency of the variables at the FrqRange prompt. 
5. Enter a y-variable to store the equation at the Sto Eqn To prompt. To do this, press VARS >, select 
Function, select a  y-variable from the list displayed. 
6. Press ENTER two times to perform the calculation. 
 
Filling a Range  
You can fill a range with text, a number, or with a formula. The range is filled beginning with the top left cell 
in the range. If you fill a range with a formula, relative cell references or range references are adjusted as 
the range is filled. 
1. Select Menu, and then select Options > Fill Range. 
2. Enter the spreadsheet range that you want to fill (for example A1:A10), and then press ENTER. 
3. Enter the text, number, or formula at the Formula prompt. Note If you enter a formula, it must begin with 
an = or +. 
4. Press ENTER two times to fill the range. 
 
Entering a Sequence  
1. Select Menu, and then select Options > Sequence. 
2. Enter the beginning cell address at the 1st Cell prompt (for example, D5), and then press ENTER. 
3. Enter the arguments for the sequence function at the seq( prompt, and then press ¯. (Example: 
seq(x,x,3,10,2) for the sequence 3, 5, 7, 9.) 
4. Select either Down or Right (to enter the number sequence down the spreadsheet or across the 
spreadsheet), by moving the cursor to the option and pressing ENTER. 
5. Press ENTER to return to the spreadsheet and enter the sequence. 
 
Importing and Exporting Data  
Note When you export data from a range of cells, empty cells in the range are treated as if they contained 
the value 0. 
Importing Data from a List 
1. Select Menu, and then select Options > Import/Export >Import List. 
2. Enter the list name at the List Name prompt, and then press ENTER. 
Tip You can enter the list name, or select it from the LIST NAMES menu (GRAPH). 
3. Enter the cell address for the first cell where you want the list imported at the 1st Cell prompt, and then 
press ENTER. 
4. Select Down to import the list into a column, and then press ENTER.—or— 
Select Right to import the list into a row. 
5. Press ENTER two times to import the list. 
Exporting Data to a List 
Note Exporting data from a row takes much longer than exporting data from a column. 
1. Select Menu, and then select Options > Import/Export > Export List. 
2. Enter the range to export at the Range prompt, and then press ENTER 
3. Enter the list name at the List Name prompt. Tip You can enter the list name, or select it from the LIST 
NAMES menu (GRAPH). 
4. Press ENTER two times to export the list. 
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Working with Charts  
Creating a Scatter Chart  
1. Select Menu, and then select Charts > Scatter. 
2. Enter the range for the X-coordinates at the XRange prompt. 
Tip - You can select a range that you want to chart before you select the chart type. The range is 
automatically entered at the appropriate prompts. 
Press ENTER to move the cursor to the each subsequent prompt. 
3. Enter the range for the Y-coordinates at the YRange1 prompt. 
4. If necessary, enter YRange2, and YRange3. 
5. Enter a title for the chart at the Title prompt. 
Tip - Alpha-lock mode is on when you move the cursor to this prompt. 
Entering a title for the chart is optional. 
6. Select either AxesOn, or AxesOff (to turn the X and Y axes on or off) by moving the cursor to the 
selection and pressing ENTER. 
7. Select either DrawFit or Draw by moving the cursor to the selection and pressing ENTER. The chart is 
displayed. 
Note The DrawFit option changes the window settings so that the chart is displayed on the screen. If you 
select Draw, the chart might be displayed outside of the viewing window. 
8. To see the X and Y coordinates for each point, press TRACE, and then use the arrow keys to move from 
point to point. 
9. Press 2nd QUIT two times to exit trace mode and return to the spreadsheet. 
Note If necessary, you can change the window settings for the chart. 
1. From the CHARTS menu, select Scatter Window. 
2. Change the values as necessary, and then either select Draw to display the chart or select  
Creating a Line Chart  
1. Select Menu, and then select Charts > Line. 
2. Enter the range for the X-coordinates at the XRange prompt (for example A2:A11), and then press 
ENTER. 
Tip - You can select a range that you want to chart before you select the chart type. The range is 
automatically entered at the appropriate prompts. 
Press ENTER to move the cursor to each subsequent prompt. 
3. Enter the range for the Y-coordinates at the YRange1 prompt (for example B2:B11). 
4. If necessary, enter YRange2, and YRange3. 
5. Enter a title for the chart at the Title prompt. 
Tip Alpha-lock mode is on when you move the cursor to this prompt. 
6. Select either AxesOn, or AxesOff (to turn the X and Y axes on or off) by moving the cursor to the 
selection and pressing ENTER. 
7. Select either DrawFit or Draw (to select the window settings for the drawing) by moving the cursor to the 
selection and pressing ENTER. The chart is displayed. 
Tip The Draw Fit option changes the window settings so that the chart is displayed on the screen. If you 
select Draw, the chart might be displayed outside of the viewing window. 
8. Press TRACE and use the arrow keys to view the data elements. 
9. Press 2nd QUIT twice to return to the spreadsheet. 
Note If necessary, you can change the window settings for the chart. 
1. From the CHARTS menu, select Scatter Window. 
2. Change the values as necessary, and then either select Draw to display the chart or select Save to save 
the window settings and return to the spreadsheet. 
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Creating a Bar Chart  
1. Select Menu, and then select Charts > Bar. 
2. Enter the range for the category labels at the Categories prompt, and then press ENTER. 
3. Enter the range for the first category at the Series1 prompt, and then press ENTER. 
Tip - You can select a range that you want to chart before you select the chart type. The range is 
automatically entered at the appropriate prompts. 
Press ENTER to move the cursor to each subsequent prompt. 
4. Enter a name for the first category at the Ser1Name prompt. 
Tip - Alpha-lock mode is on when you move the cursor to this prompt. 
5. Enter the range for the second category at the Series2 prompt. 
6. Enter a name for the second category at the Ser2Name prompt. 
7. If necessary, enter the range for the third category at the Series3 prompt. 
8. If necessary, enter a name for the third category at the Ser3Name prompt. 
9. Enter a title for the chart at the Title prompt. 
Tip- Alpha-lock mode is on when you move the cursor to this prompt. 
10. Select either Vertical, or Horiz (to display the chart either vertically or horizontally) by moving the 
cursor to the selection and pressing ENTER. 
Tip - You can return to the BAR CHART screen later and change the display without having to enter the 
other parameters again. 
11. Select either DrawFit or Draw (to select the window settings for the drawing) by moving the cursor to 
the selection and pressing ENTER. The chart is displayed. 
Tip - The DrawFit option changes the window settings so that the chart is displayed on the screen. If you 
select Draw, the chart might be displayed outside of the viewing window. 
If the entire chart will not fit on one screen; arrows are displayed on the left side of the screen. Press the 
arrow keys to view the part of the chart that is not currently displayed. 
12. Press TRACE and use the arrow keys to view the data elements. 
13. Press 2nd QUIT twice to return to the spreadsheet. 
Note If necessary, you can change the window settings for the chart. 
1. From the CHARTS menu, select Scatter Window. 
2. Change the values as necessary, and then either select Draw to display the chart or select Save to save 
the window settings and return to the spreadsheet. 
 
Creating a Pie Chart  
1. Select Menu, and then select Charts > Pie. 
2. Enter the range for the category labels at the Categories prompt. 
Tip - Press ENTER to move the cursor to each subsequent prompt. 
3. Enter the range for the chart at the Series prompt. 
Tip - You can select a range that you want to chart before you select the chart type. The range is 
automatically entered at the appropriate prompts. 
4. Select Number or Percent by moving the cursor to the option and pressing ENTER. 
Tip - If you select Number, the data from the spreadsheet is displayed in the pie chart. 
If you select Percent, the percentage of the whole that each data element makes up is displayed in the pie 
chart. 
5. Enter a title for the chart at the Title prompt. 
Tip - Alpha-lock mode is on when you move the cursor to this prompt. 
6. Select Draw to display the chart. 

2/28/02 © 2001 Texas Instruments 
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Glossary  
Terms used in the field of wildlife management 

 
Anadromous: species of fish that live their lives in the ocean and return to the 
freshwater rivers where they hatched to spawn.  In Virginia, the striped bass, 
shad, sturgeon and herring are all anadromous fish. 
 
Carrying Capacity: the maximum number of individuals that a given 
environment can support without detrimental effects to the ecosystem. 
 
Ecosystem: a natural unit that includes living and nonliving parts interacting to 
produce a stable system in which the exchange of materials between the living 
and nonliving parts follows closed paths. 
 
Fledgling:  a young bird who has the feathers necessary to begin to fly or to 
leave the nest. 
 
Hatchery:  where fish are hatched or raised until released, also called a fish 
cultural station.  
 
Hibernation: the act of passing the winter, or a portion of it, in a state of sleep; a 
torpid or resting state. 
 
Limiting factors: influences in the life history of any animal, population of 
animals, or species (e.g. food, water, shelters, space, disease, predation, 
climate conditions, etc) 
 
Mast: The fruits or nuts of wild plants and trees.   
 
Riparian buffer: the area of land along a stream, river, lake or other body of 
water.  The plants along this edge hold soil and filter runoff before it reaches the 
waterway. 
 
Waterfowl:  water birds, usually refers to ducks, geese and swans. 
 

Some definitions are from the Project WILD activity guide glossary.  
 Additional information about Project WILD in Virginia is below. 
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Thank you for using this guide with your students . In addition to building math skills, the 
activities will increase understanding of Virginia’s wildlife resource and how local scientists 

use math to answer biological questions.  
 

For more information about Virginia’s wildlife resources visit us on the web at 
www.dgif.virginia.gov .  The Department provides a Virginia Wildlife magazine subscription 

to all public schools in the Commonwealth.  The magazine will provide your class with 
additional information on wildlife research projects as results are published. 

 
The Virginia Department of Game and Inland Fisheries is the state sponsor of  

Project WILD, a K-12 wildlife education program available through free workshops.  If you 
are interested in attending a Project WILD workshop contact: 

 
Suzie Gilley, 

Wildlife Education/ Project WILD Coordinator  
Department of Game and Inland Fisheries 

P. O. Box 11104 
Richmond VA 23230-1104 

804/367-0188 
suzie.gilley@dgif.virginia.gov 
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